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Introduction

Introduction

The purpose of this document is to explain how to use InEight Document Reporting APIs in a step-by-step
fashion and allow third party organizations to easily interface applications they use with InEight
Document Reporting module.

Examples in this document are for demonstration purposes only.

Itis essential that any third-party organization using the APIs first signs an agreement to keep this
document confidential and what it can achieve. Furthermore, it is important that the APIs are only used
for the purpose it is provided and that they are not misused to make spurious calls on the InEight
Document Reporting API.

Using the InEight Document Reporting API Service

InEight Document always operates based on a single user’s security settings as configured by the project
administrators. The InEight Document Reporting APIs are no different. All InEight Document Reporting API
functions require an active user session identifier to be passed in order to authorize any activity and will
be limited by the user’s access limitations.

This active user session identifier is known as the “sessionKey” which is returned when a user logs in
using the following.

e UserlD

e CompanylD

e Password

e Project Number

IMPORTANT: The sessionKey should be retained and re-used for any immediate API calls and then to have
the session invalidated at the end of the application/process cycle.

The session initiate method is the only exception which does not require a session key authorization. See
section 4.1.1 on how to authorize the InEight Document API requests with the session key.
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InEight DOCUMENT Reporting Function

InEight DOCUMENT Reporting Function

Report Types

To understand what the Reporting APIs will return the users need to be acquainted with the Reporting
function in the DOCUMENT application. This is where all the available report types can be seen, and the
APIs will work based on each individual report type.

Step 1: Open the Reports Module

@ Eul Praject Delivery Demo 3 - with Project Suite - Google Chrome

@ aul.docineight.com/DooumentSuite/fibetcal-11ed-dola-Boeb-bfT ced2 38881 Diash board

Doscurment f Dashboard EUI Progect Dedvery Demo 3 - with Pr

Das

1 ]
- - Mal -
&1 Project Announce i1 Workflow Il"_'|
Mo Announcements LT Total overdue o

1 ToReview =
'| Al overdue reniews
0 Al overdue releases

1 Awwaiting aCtrvalion

-
» - Pe

&= Mail B Transmittals
Peraonal - Tatal overdue 0 Persanal - Total averdue 0

0 Bew i . 0 Total sent
(] nbox ifems awaiting response 0 Total recerved
0 Senlitems Swalling responts 0 sentwith an acknowledgement pending

Figure 1: Click on “Reports” from DOCUMENT dropdown menu
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Step 2: Check Out the Standard Reports

@ Standard Reports

REPORTS

Customize report Yr  Addto favourites

01 Address Book ~
02 Administration ~ B
E Report details
04. Document Register ~
001 - Details Report Title:
015 - Summary - by Status & Revision Details
020 - Document Access Details - by Docume
025 - Document Access Details - by User Run Report

060 - Distribution Matrix Unassigned Users +
< »

@ nNow O onDate

05. Transmittals Repeat:

07. Document Workflow One time only
10. Mail
15. Packages

25 Folder

Cf<<]€]<]<

40. Forms

Search conditions

Set search conditions for Documents
Show:
Latest

Field name

@ Select one..

(#) AND | Selectone

© 2023 InEight Inc. | Privacy Statement | Terms & Conditions | ¥23.06.06

Figure 2: Navigation Pane to run the Standard Reports

SCHEDULED

Manage advanced search

Iaximum records to display:

Date and Time:(UTC +10:00)

FAVOURITES

Save search Clear search
a
10000
Export As:
=] . e ,
& POF Excel csv Word

For how long?

No end date
v
Condition
v Select one...
v Select one

£nd date and time:(UTC: +10:00)

Documents that | can download A
Value
v Select some items. - ®
v Select some items. * X .
INEIGHT |

The available Report types are listed in the left-hand pane and note that the reports are categorised as
Address Book, Administration, Document Register, Transmittals and so on. Under each category there are
multiple different report types which users can run by selecting the filters and clicking on the “Search”

button.

The format an individual report is numbered is XX.YYY where XX is the category number and YYY is the

report identifier.

Some of the report types can be seen below.

Report No | Title

04.001 Document Register by Details

05.001 Transmittal Details by Transmittal No
40.950 Forms RFI Log

40.001 Forms Summary

For detailed information on the different report types please go to REPORTS.



https://learn.ineight.com/Document_Enhanced/Content/Reports/ReportsStart.htm
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The Reporting APIs

The Reporting APIs

Using the Reporting APIs in Swagger

Swagger is in essence a set of open-source tools to develop, document and use RESTful web services also
known as RESTful APIs. The tool will serve the purpose of making the Reporting API calls which will return
responses in a human-readable text format -JSON.

What is required?

o URL to access Swagger: https://server/TBReportingAPI/
o The user needs to know which server the instance of DOC is hosted in.

o This can be acquired from URL bar when logged in the DOCUMENT application.
@ Standard Reports - Google Chrome

# aul.docineight.comfDocumentSuite/f1be6ca3-11e0-4c0a-8ceb-bfTced23888f/Reports/0

@ Standard Reports

REPORTS SCHEDULED FA\
01. Address Book " Customizereport Y4  Add to favourites Mat
02. Administration v | .
Report details

04. Document Register ~

001 - Details = Report Title: Maximum records to ¢

015 - Summary - by Status & Revision Details

020 - Document Access Details - by Docume

025 - Document Access Details - by User Run Report: Date and Time:(UTC +

060 - Distribution Matrix Unassigned Users - @® Mow ) OnDate

4 >

Figure 3: In this example, the URL will be https://aul.doc.ineight.com/TBReportingAPI/

e UserlD
e CompanylD
e Password
e ProjectNo
o Itneedsto be ensured that the Project is enabled for the Reporting APIs otherwise the API will

return “invalid project id”. The system admin should be contacted when this error message pops
up.
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Making API calls Step by Step

Step 1: Open Swagger and click on Session

3} swagger hitps:/fau1 doc.ineight com/TBReportingAPl/iswagger/docs/vi Explore
TBReportingAPI
Report Show/Hide | List Operations | Expand Operations
Session Show/Hide | List Operations | Expand Operations
User Show/Hide | List Operations | Expand Operations
[ BASE URL: /TBReportingAPI , Api VERSION: V1 | D)

Figure 4: Swagger User Web Interface

Step 2: Click on POST /Session

TBReportingAPI
Report Show/Hide | List Operations | Expand Operations.
Session Show/Hide | List Operations = Expand Operations.

/Session ISession
@ Session

User ShowfHide | List Operations | Expand Operations
[ BASE URL: /TBReportingAP! , APl VERSION: v1 ] INVALID

Figure 5: Post /Session APl Request to log the user in and generate the sessionKey.
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Step 3: Click on JSON Code Example Value

TBReportingAPI

REPOIT Show/Hide | List Operations | Expand Operations

Session Show/Hide = List Operations = Expand Operations

/Session ISession
/Session Session

Implementation Notes
Create a InEight Document session for use with the InEight Document Reporting API (Login)

Response Class (Status 200)
OK

Wodel Example Value

{3

Response Content Type | applicationfjson v

Parameters
Parameter Value Description %:’a;aemeler Data Type
userInfo (required) The APl access enabled body Model Example Value
user's InEight Document
login information. {
“UserID": “"string”,
oneTimePassword “CompanyID”: “string",
~ parameter is optional “Password": "string”,
unless two-factor "Projectio”: "string",
Parameter content type: authentication enabled for “oneTimePassword”: "string",
[ applicationijson - user. application™: "string®
1
User Show/Hide | List Operations | Expand Operations
[ BASE URL: /TBReportingAPI , API VERSION: V1 ] )

Figure 6: Once clicked, the code template will be brought across into the blank userinfo field.
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Step 4: Fill in the required fields and click on “Try it Out” button.

Response Content Type | application/json v

"UserID": "ATORAMAN",
"CompanyID”: "InBtst™,

"Password”: "xyzl23",
"ProjectNo™: "abc456",
"oneTimePassword™: "",

"Application”: "APITest"

Parameter content type:
| applicationijson -

o ]

Parameters
Parameter Value Description
userInfo n The APl access enabled

user's InEight Document
login information.

oneTimePassword
parameter is optional
unless two-factor
authentication enabled for
user.

Figure 7: The users put in their credentials and specify the Project.

Step 5: Copy the sessionKey

Request URL

https://aul.doc.ineight.com/TBReportingAPI/Session

Response Body

HoleelB]l-236e-483b3-adT5-e8cdchbal2dol

Response Code

2el

Figure 8: The response code 201 is for the successful APl calls.

10
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Step 6: Click on Report

TBReportingAPI

Report

Session

User

[ BASE URL: /TBReportingAP| , APl VERSION: V1 ]

Show/Hide | List Operations | Expand Operations
Show/Hide | List Operations | Expand Operations

Show/Hide | List Operations | Expand Operations

INVALID

Figure 9: Report is where all the Reporting APIs can be accessed.

Step 7: Click on the API GET /Report/{reportNo}

TBReportingAPI

Report
/Report/{reportNo}/Filter/{filterTitle}

vl /Report/{reportNo}/Filter/{filterTitle}

JReport/{reportNa}/{filterTitle)

Session

User

[ BASE URL" /TBReportingAP! | APl VERSION® V1 ]

Show/Hide  List Operations  Expand Operations

Report/{reportNo}/Filter/{filterTitle}
Report/{reportNo}/Filter/{filter Title}
Report/{reportNo}/{filter Title}

Report/{reportMa}

Show/Hide | List Operations = Expand Operations

Show/Hide | List Operations = Expand Operations

INVALID

Figure 10: This API returns the Report Data based on the Report Type without any Filtering.

Step 8: Specify the Report Type

e Ascan be seen from the Report function in the DOCUMENT web application, the report number is
required to be putin “reportNo” field. Refer 3.1 in this document.

Step 9: Put in the sessionKey into the Authorization field preceded by “basic” and a space.

11
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Step 10: Click on the “Try it Out”

/Report/{reportNo} Report/{reportNo}

Implementation Notes
Get Report data without specifying a filter.

Response Class (Status 200)
OK

Model Example Value

{3

Response Content Type | application/json v

Parameters
Parameter Value Description Parameter Type Data Type
reportho | 04.001 | The reportno to be run-in  path string
XX.YYY format.
Authorization ﬂhasic 462ee201-286e-48b3-adf5-e8c0cbaT2d91 |1 The InEight Document header string
Reporting API generated
active SessionKey , prefixed
with "basic ".
$skip | | The number of results to skip query integer
(optional).
$top | | The number of results to return ~ query integer
(optional).

Figure 11: reportNo and Authorization are the required fields.

NOTE: $skip and $top are the optional fields that allows for pulling in a specified number of results out of
the whole Report data.

e The following example will return the top 10 records.
o $skip=0
o S$top=10

Step 11: Check out the result

e |tshould be noted that the Response is in JSON format.
e The successful API call will return 200 as the response code.

12
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Request URL

https://aul.doc.ineight.com/TBReportingAPI/Report/@4.081

Response Body

"Int_Key": 8,

"CheckedOutvValue": "No",

"Checkedout": @,

"DocumentMo™: "146-18W-RSSTRUCTUREERECTI-22@-47-REPORT",
"Rev": "A",

"sts"; "IFIM,

"Title": "146-18W-RSStructureerecti-228-47-Report”,
"Discipline™: "ADM",

"Category”: "",

"Type": "CER",

"AvlDwgFmts": 1,

"Int_Apprvd": -1,

"RvwStatus": “"Un-Restrained”,

"FromId": "WBURROWS™,

"Approved”: "2020-89-22T13:53:54.873",

"FirstName™: "William",

"LastMame": "Burrows",

"Company™: "InEight”,

Response Code

e

Figure 12: When the required fields are not correct, the Response Code will be 500 and an error message will pop up.

Ending the Session

It is critical that once the users are done with using the APIs, it is recommended that the active session is

ended. The API type that will be used to log the user off is “DELETE”.

TBReportingAPI

Report

Session

DELETE

/Session

User

Show/Hide | List Operations | Expand Operations

Show/Hide = List Operations =~ Expand Operations

ISession

Session

Show/Hide | List Operations | Expand Operations

Figure 13: Delete can be found under Session.

Step 1: Click on Delete

Step 2: Paste the sessionKey in the Authorization field preceded by “basic” and a space.

13
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Connecting Reporting APIs with Power BI

Step 3: Click on “Try it Out”

Session Show/Hide = List Operations = Expand Operations

/Session [Session

Implementation Notes
Delete the session (Logoff)

Response Class (Status 200)
OK

Model Example Valug

{3

Response Content Type | application/json v

Parameters
Parameter Value Description Parameter Type Data Type

Authorization| basic 1cb22815-53af-4984-aa99-401cc12545ad | | The InEight Document header string
— Reporting API generated

active SessionKey , prefixed
Try it outl |Hide Response

with 'basic ",
Figure 14: Delete method log the user off and make the sessionKey invalid.

Step 4: Check out the Response Code

Curl

curl -X DELETE --header ‘Accept: application/json' --header 'Authorization: basic 1cb22815-53af-4984-2a399-4@1ccl2545ad” 'https://a
3

4
Request URL

https://aul.doc.ineight.com/TBReportingAPI/Session

Response Body

no content

Response Code

2ga

Figure 15: The successful Delete request will return 200 as the response code.

Connecting Reporting APIs with Power Bl

Project View Reporting Instructions

Power Bl is in essence a tool to connect and visualize data and the following steps will explain how to
bring the REPORT data from InEight DOCUMENT application into Power BI.

14
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Connecting Reporting APIs with Power BI

Step 1: Launch Power Bl Desktop.

Step 2: Go to the Home tab and click on Get Data dropdown and select Blank Query.

Untitled - Power Bl Desktop

|e @ Insert  Modeling  View  Help
ChaebEDLD PR ARE 88 | a

Excel PowerBl SQL Enter Recent Transform Refresh New Text More New  Quick Publish
clatasets Server data sources~ data v visual box visualsv | measure measure

Clipboard Queriss Insert Calculations Shars
Common data sources

[B Ecel

= B8 Power Bl datasets
ug [B Power 81 datafiows
[B sotserver

[& Analysis Services

[By tescsv

B web
[By OData feed

ﬁb - Add data to your report

B2 Power B[ Wite 2 query from scrateh. | Once loaded, your data will appear in the Fields pane.

= s !

Import data from Excel Import data from SQL Server Paste data into a blank table Try a sample dataset

Figure 16: The query editor will pop up

Step 3: Go to Manage Parameters under the Home Tab and click on “New Parametres”

1| H = | Untitled - Power Query Editar
Transform Add Column View Tools Help
Iix. D [E) % T D [/ Properties I:I LI |
i< |
LRy 1+ % [E] advanced Editor x EE

Close & New Recent  Enter Data source Manage Refresh Choose  Remove Keg

Apply~  Source ~ Sources = Data settings Parameters=| Preview - [ Manage - Columns = Columns = Row
Close Mew Query Data Sources Manage Parameters ery Manage Columns Re
Queries [1] ¢ Edit Parameters

Jx
Mew Paramegter 1
A% Queryl | E?

Create a n-ew parameter that can be
referenced by other queries in this
file,

Figure 17: The same URL that allowed for accessing Swagger will be defined as the parameter

Step 4: Type “APIURL” in the Name field.

15




INEIGHT @

Connecting Reporting APIs with Power BI

Step 5: Paste the urlin the Current Value field.

e Theurl will be https://server/TBReportingAPI/

e |tcanbe acquired once logged in the DOCUMENT web application.
@ Standard Reports - Goagle Chrome

# aul.doc.ineight.comfDocumentSuite/f1bebca3-11e0-4c0a-Bceb-bfTced?3885f/Reports/0

@ Standard Reports

REFORTS SCHEDULED FAN
01. Address Book Customizereport Yy  Add to favourites Mat
02. Administration v | .
Report details

04. Document Register ~

001 - Details Report Title: Maximurm records to ¢

015 - Summary - by Status & Revision Details

020 - Document Access Details - by Docume

025 - Document Access Details - by User Run Report: Date and Time:(UTC +

060 - Distribution Matrix Unassigned Users « ® Now ) OnDate

1 »

Figure 18: In this example, the URL will be https://aul.doc.ineight.com/TBReportingAPI/
Step 6: Click OK.

#l | | G5~ = | Inkight Document Data_rd - Power Query Editor
Home Transform Add Column View Tools Help

E: D [‘3} % I:a [‘2’ [y Properties I:l L>(J E-;\? E-EE gt F'"\ % Data Type: Any = [ Merge Queries - = Text Analytics

5} Advanced Editor [ Use First Row as Headers = 5 Append Queries = <@ Vision
Close &  New Recent Enter Datasource  Manage  Refresh Choose Remove  Keep Remove Split  Group
Apply~  Source - Sources~ Data settings  Parameters~  Preview = £ Manage = Columns - Columns -  Rows = Rows - Column~ By =z Replace Values [EZ] combine Files A saure Machine Learning
Close New Query Data Sources  Parameters Query Manage Columns Reduce Rows  Sort Transform Combine Al Insights
Queries [1] <

Current Value

httpsi//aul.doc.ineight.com/TBReportingAPL/

Manage Parameters

e

Name

Description

| A% APIURL

& Required

Type

[Te ]
Suggested Values

Current Value
[ hittpsy/7aut.doc.neight.com/TEReportingAPl/ 1

- Caree

Figure 19: This will define the URL as the parameter to be used in the query
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Step 7: Click on New to add the following parametres and then click OK

e Userld

e Company
e Password
e Project

Ml | | O~ = | InEight Document Data_r) - Power Query Editor
Home Transform Add Column View

Toals Help

Ii)g I:h. % [!; D [z Properties |:| LpJ o/ - S 1 % Data Type: Any - T Merge Queries ~ | = Text Analytics
?9 ~
L) i+ ®7 T Advanced Editor X HH HH zl an [ Use First Row as Headers = - Append Queries = €@ Vision
Close &  Mew Recent Enter  Data source Manage Refresh Choose  Remove Keep Remove split  Group |
Apply~  Source  Sources~ Data settings Parameters~  Preview~ [2] Manage ~ Columns ~ Columns = Rows = Rows = Column~ By 2 Replace Values Combine Files é Azure Machine Learning
Close New Query Data Sources  Parameters Query Manage Columns Reduce Rows Sort Transform Combine Al Insights
Queries [12] £
Current Value
b Functions [1] R |
b B0 Queries to Load [6]
4 ol Manzge Parameter Manage Parameters
APIURL (https:/fauT.docir om/TBl inaABL)

Name
Userd
Company (QAS) 2B Userld x Description
Password (ABC123456) A Company
Project (ProjectX¥Z) A Password
aB Project
& Required

Type
Suggested Values

Current Value
|oF

Cancel

Figure 20: Adding other parametres to enable Reporting API calls

Step 8: Click on Queryl and then click on Advanced Editor under the home tab.

i I'd D@v = | InEight Document Data_r0 - Power Query Editor
Home Transform Add Column WView Tools

CLhE G 3 B £ %

Close & MNew Recent

Enter Data source Manage Refresh Choose  Remove
Apply~  Source ~ Sources~ Data settings Parameters ~  Preview Columns - Columns ~
Close New Query Data Sources  Parameters Manage Columns
Queries [13] < Advanced Editor

Open the Advanced Query Editing
dialog to view or modify the entire
text for this query.

I Functions [1]
b ] Queries to Test [6]
4[| Queries to Load [1]

eries [3]

Figure 21: Queryl will be edited to enable extraction of Document data

17
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Connecting Reporting APIs with Power BI

Step 9: Copy and paste the following script and fill in the required fields.
Type in the Report number in the format of XX.YYY

e Report numbers can be found in the Report function in the DOCUMENT web application as well as
via this link. REPORTS

let
Source =

(Web.Contents(APIURL, [Headers=[Accept="application/json", #"Content-Type"="application/x-www-form-
urlencoded;charset=UTF-8"],

Content=Text.ToBinary("UserID="& Userld &
"&CompanyID="&Company&"&Password="&Password&"&ProjectNo="& Project & "&Application=APIDemo"),
RelativePath="session"])),

SessionKey = Json.Document(Source),
SessionKeyHeader = "Basic " & SessionKey,

Sourcel=Json.Document(Web.Contents(APIURL, [Headers=[Authorization=
SessionKeyHeader],RelativePath="Report/04.001" , Timeout=#duration(0,0,30,0)]))

in

Sourcel

IMPORTANT: Identifying which reports to call is driven by the organisation’s own reporting requirements.
The script above will extract 04.001 Document Register against a single Project.

Step 10: Click on DONE.

il Advanced Editor O *

Q U e ry1 Display Options ~ 0

1 let

2  Source =

3 (Web.Contents(APIURL, [Headers=[Accept="application/json”, #"Content-Type"="application/
®-www-form-urlencoeded; charset=UTF-8"],

4 Content=Text.ToBinary("UserID="& UserId & "&CompanyID="&Company&"&Password="&Password&"&Projectho="&
Project & "&Application=APIDemc"), RelativePath="session"1)),

5  GSessionkey = Json.Document{Source),

& SessionkeyHeader = "Basic " & SessionKey,

7 Sourcel= Json.Documentikeb.Contents(APIURL, [Headers=[Authorization= SessionKeyHeader],
RelativePath="Report/@84.881" ,Timeout=#duration(8,@,3@,8)]))

8 in

9 Sourcel

r\/ No syntax errors have been detected.1

=

Figure 22: Query1 script

18


https://learn.ineight.com/Document_Enhanced/Content/Reports/ReportsStart.htm

INEIGHT @

Connecting Reporting APIs with Power BI

(o =1 List Tools InEight Document Data_r0 - Power Query Editor

Home Transform Add Column View Tools Help Transform

E| B, B - Remove Duplicates £ XO
HH 2 Reverse ltems £ =
To Keep Remove Statistics
Table  ltems~ ltems~ -
Convert Manage Items Sort Numeric List
Queries [13] < fx || = Ison.Document (Meb. Contents (APIURL, [Headers=[Authorization= SessionkeyHeader],RelativePath="Report/@4.801" ,Timeout=#duration(8,0,38,8)1))

N —

b 0 Queries to Test [6] Record

4 [ Queries to Load [1]
B

b [ Other Queries [5]

Record
Record

Record

1

2

3

4

5 | Record
6 Record
7 | Record
8 | Record
9 | Record
10 | Record
11 |Record
12 |Record
13 | Record
14 | Record
15 | Record
16 | Record
17 | Record
18 |Record
19 |Record
20 |Record

Figure 23: All individual Records will be pulled in. In this example, the report type is 04.001 i.e. Document List, every record from the
Document Register.

Step 11: Click on “To Table” under the File tab and click on OK.

A0 =1 ListTools InEight Document Data_r0 - Power Query Editor
Home  Transform  AddColumn  View  Tools  Help | Transform
EE Wy W [-f Remove Duplicates 5| XO
= Reverse ltems i
To Keep Remove Statistics
Table Items = Items ~ -
Convert Manage ftems Sort  Numeric List
Queries [13] < Jft | = Ison.Document(Meb.Contents(APIURL, [Headers=[Authorization= SessionKeyHeader],RelativePath="Report/24.001" ,Timeout=#duration(@,?,32,2)]1))
b Wi Functions [1]
I ] Queries to Test [6] 1 | Record
411 Queries toLoad [1] 2 [Recnd
+ I
4 Record
b [ Other Queries [5]
5 | Record %
6 |Record To Table
7 | Record
& | Record Create a table from a list of values.
Bl Select or enter delimiter
10 Record |Nur|e - ‘
11 |Record
How to handle extra columns
12 | Record
[ show as errors -]
13 | Record
14 | Record
15 | Record
16 | Record
17 | Record
18 | Record
19 | Record
20 |Record

Figure 24: This will convert all the records into Table format.
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Connecting Reporting APIs with Power BI

Step 12: Click on Expand Columns button and then OK.

InEight Document Data_r0 - Power Query Editor

File Home Transform Add Column View Tools Help

=X 7 Properties LI o/ 4 I Data Type: Any ~

i (5[0 B [3 s o B X B b =g

Lo Erndvanced Editor [T Use First Row as Headers +

Close & MNew  Recent Enter  Datasource Manage Refresh Choose  Remove Keep Remove Split  Group 4
Apply~  Source > Sources~ Data settings Parameters =  Preview = [ Manage ~ Columns ~ Columns * Rows~ Rows~ Column~ By s ReplaceValues

Close Mew Query Data Sources  Parameters Cuery Manage Columns Reduce Rows Sort Transform

Queries [13] < f

b W Functions [1]

I Queries to Test [6]

L Queries to Load [1]
[ Queryl

[ Other Queries [5]

‘ Search Columns to Expand

M (Select All Columns)
Int_Key

B CheckedOutValue
& CheckedOut

@ DocumentNo

@ Rev

Sts

8 Title

@ Discipline

@ Category

& Type
AviDwgFmts

& Int_Apprvd

M@ RvwStatus

@ Fromid
Approved

@ FirstName

[ IR

[ Use original column name as prefix

Load more

1. List may be incomplete.

|18 [Record
19 Record
20  Record

= Table.FromList(Sourcel, Splitter.SplitByNothing(), null, null, ExtraValues.Error)

Figure 25: This will convert Records table into a Pivoted Table.

Step 13: Click on Close & Apply

Home  Tansforn  AdaColmn  View  Tooks Help
K E ] B By Properties W me om0 o DsaTpeAw- B Merge Queries > == Text Anabtes
3 3+ 6l 2 [} adanced Eator X HHHH ; 7] Use First Row as Headers = 5 Append Guenies = @ Vision
New Recent Enter Datasource  Mansge  Refresh Choose  Remore  Keep Remove ot Group :
Source > Sources » Data settings  Porameters>  Prewew > (1) Manage ~ Columns » Columns > Rows > Rows = Column~ By sz Replace Vaiues (L1] Combine Fies A Azure Machine Learning
Hew Guery DataSaurces  Parameters Query Manage Columns  Reduce Rows  Sort Transtorm Combine Arinsights

Quenes 7} £ Jfc | = Table.ExpandRecondColum(a Converted to Table", "Columnl, (“IntXey", "CheckedOutValue", "Checkeddut", “Documentho”, “Rev", "Sts", *Title", "Discipline", "Category", "Type" | QuarySemings X

O Query! m. 4 PROPERTIES

B APWRL (https/wmtea.. | 1 952 No. 0 (e-G17702 Y ] tefasstastar BUGFARM [r) e
2 %6 No 0 fersaror A A tetasotastar sucraam [t Al | et
3 59 M 0 00001 5 " Second Uploadssssss Ao [F Al roperties
s N 9 00001 A " Second Uioadsssssss Ao [t . i
s 7o 0 o0oa1 s " Second Uploadssssss oM [t e
6 155 Mo 0 00001 c " Second ploadsssssss oM @ Sooe
7 22 M0 0 00001 c i Second Uploadsssssss AoMIN w Sussionkey b
8 313 Yes 1 00001 o 3 Second Uploadsssssss AOMIN [t} :‘:‘W :
) 314 Yes 1 oooan € v Second Uploadssssss som [t
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12 368 No 0 00001 " e Second Uploadsssisss e 2
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" a7 000001 SKROUPETST i 7 Second Uioad oM [
5 0 No. 0 0002 A wc PAMANREVIEW Aovn o
0 172 %0 0 o002 e " PAMANREVIEW i o
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1 27 M 0 00003 o " sarsseast Ao o
19 E 0 00003 o [ saraseast somn o
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2 5 ves 1 OOLSOUPUCATETST D " seraseasT oM
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Figure 26: This will bring across the table into Power BI.
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Step 14: Go to Data View and Check Out the Data.

Untitled - desktop Andy Toraman 63
File Home Help Table tools
e e 2 BB
Mark as date Manage New Qu ew  New
Structure. Calendars. Relat < -~
bl | X Fields >
CommnLint_Key [~] Column1.CheckedOutvalue [~] ColumnCheskegout [~ CoumnL.0ocumenttio (]| columnt.gev [~]| comumnt.sts [~]| Column1.iitie [~]| Column1.Discipine [~]| Column. [=] cotumn1ype [<]| column1.AviDweFmts [~ ] ColumnL.int_Apprva [=] Column1.fvwstatus |
B No ) 24700003 G.FI B 28 0710202075115 | ADMIN 2 1 UnRestrained A | O Search
1270 No o 24700020.B.DPAWT B AB 07102020Test20  ADMIN 2 -1 ElmmETEES
1271 No o 24700022.A.DPAWT B A8 07102020Test21 | ADMIN 2 =Y Column1.Category
1272 No o 24700023-WDEDEMO4-00001—+++++. ARCOMP B A8 071020207522 | ADMIN 2 =Y Column1.Checke.
1278 No o 24700030.A1FC < AB 07102020Test28  ADMIN 2 -1 Column1.Discipline
1275 No. 0 2470003 L.A.IF: C AB 07102020Test23__ ADMIN 2 -1 Column1.DocAcc...

Figure 27: The data table can be seen in the Data view.
Step 15: To bring in data from other reports into Power BI, repeat Step 2 and then from Step 8 onward.

Step 16: Go to the Report View and you can start building dashboards.

File Home Insert Modeling View Help
o . Ay B A &
2t GhAEDEDR| B D G
Paste o Get  Excel PowerBl 5SOL  Enter Recent Transform Refresh Mew  Text Mare Mew Quick Publish
¥ Format painter | datav datasets Server data sources- datav visual box visuals~ measure measure
Clipboard Cata Queries Insert Calculations Share

Figure 28: Dashboards can be built using the data fields i.e. columns in the data tables.

Portfolio View across all Projects

The following steps will build on the details described in the section above and will explain how to bring
the REPORT data from each InEight DOCUMENT project into Power BI.

Step 1: Launch Power Bl Desktop.
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Step 2: Go to the Home tab and click on Get Data dropdown and select Blank Query.

Untitled - Power Bl Desktop

File Insert Modeling View Help
3
zlwct BE L 2[5 A dk d | ab
Excel PowerBl SQL Enter Recent | Transform Rsfresh | New Text  More New  Quick | Publish
datasets Server data sourceswv data v visual box visualsw measure measure
Clipboard Queries Insert Calculations Share
Common data sources
ool
[By excel
= (8 Power Bl datasets
a2 [ Power Bl dataflows
[} satserver
[ Analysis Services
[B rearcsy
[& web
& OData feed
ﬁ . Add data to your report
ankquﬁy
B2 Power B Wite » query from scratch. | Once loaded, your data will appear in the Fields pane.
Mare...
x5 =
x i ¥
U <
Import data from Excel Import data from SQL Server Paste data into a blank table Try a sample dataset

Figure 29: The query editor will pop up.

Step 3: Go to Manage Parameters under the Home Tab and click on “New Parametres”

J | | = | Untitled - Power Query Editor
Transform Add Column View Tools Help
Ex & [E) % &y Y [y Properties I:l Lp i
I
- 3+ = [=] Advanced Editor x HE
Mew

Close & Recent  Enter Data source Manage Refresh Choose  Remove Keg
Apply~  Source ~ Sources = Data settings Parameters=| Preview - [ Manage = Columns =~ Columns = Row
Close Mew Query Data Sources Manage Parameters ery Manage Columns Re
Queries [1] < fx Edit Parameters
Mew ParamEt;r
.Anc Queryl

Create a n'ew parameter that can be
referenced by other queries in this
file,

Figure 30: The same URL that allowed for accessing Swagger will be defined as the parameter.
Step 4: Type “APIURL” in the Name field.
Step 5: Paste the urlin the Current Value field.

e Theurl will be https://server/TBReportingAPI/
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e It canbe acquired once logged in the DOCUMENT web application.
@ Standard Reports - Google Chrome

DocumentSuite/f1bebca3-11e0-4c0a-Bceb-bf7ced23888f/Reports/0

8 aul.docineight.co

@ Standard Reports

REPORTS SCHEDULED FAN
01. Address Book " Customize report  Y¥  Add to favourites Mai
02. Administration v | -
Report details

04. Document Register ~

001 - Details Report Title: Maximum records to ¢

D15 - Summary - by Status & Revision Details

020 - Document Access Details - by Docume

025 - Document Access Details - by User Run Report: Date and Time:(UTC +

060 - Distribution Matrix Unassigned Users - @® now O OnDate

] 3

Figure 31: In this example, the URL will be https://aul.doc.ineight.com/TBReportingAPI/

Step 6: Click OK.

dl | |H G- = | Inkight Document Data_rd - Power Query Editer
Home Transform Add Column View Tools Help
[X [h % I:B. D [ Properties |:| Ly Y e 4| ] =1 Data Type: Any = 5 Merge Queries ~ = Text Analytics
?D ~
= L: ) ®7 =} Advanced Editor X HH HH zl an [7] Use First Row as Headers - - Append Queries - <& Vision
Close &  New Recent Enter Datasource  Manage  Refresh Choose Remove  Keep Remove Split  Group ,

Apply~  Source~ Sources~ Data settings Parameters~  Preview = L1 Manage = Columns = Columns = Rows~ Rows ™ Column~ By <3 ReplaceValues @Cﬂmhm Files AAZWE Machine Learning

Close New Query Data Sources  Parameters Query Manage Columns Reduce Rows  Sort Transform Combine Al Insights

Queries [T <
Current Value

| APIURL inei ingAPl/ htps://aul.doc incight.com/TBRepartingAPl/

Manage Parameters

Name

Description

| A% APIURL

@ Required
Type
Suggested Values

Current Value

[Fmze/su dicins grcon TiRagaring 1

Cancel

Figure 32: This will define the URL as the parameter to be used in the query.
Step 7: Click on New to add the following parametres and then click OK

e Userld
e Company
e Password
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Al | | D = | InEight Document Data_rf) - Power Query Editor
Home Transform Add Column View Tools

Company (QAS)
Password [ABC123456)

Help

E)g D % [‘\ I:b, [ Properties |:| LpJ [ o T % Data Type: Any E5 Merge Queries - = Text Analytics

‘S) ~

Loy L4 ®s  [5} Advanced Editor X HH HH : riin [ Use First Row as Headers = 2= Append Queries = <@ Vision
Close &  New Recent Enter Datasource  Manage  Refresh Choose Remove  Keep Remove Split  Group
Apply~  Source - Sources - Data settings Parameters = Preview~ [ Manage ~ Columns * Columns = Rows~ Rows ™ Column~ By '37Replace Values Cﬂmbm Files Aﬁzm Machine Learning
Close New Query Data Sources  Parameters Query Manage Columns Reduce Rows  Sort Transform Combine Al Insights
Querias [12]

Current Value

b 1 Functions [1] L ‘

b 9 Queries to Load [6] X

4 Other Queries [5] Manage Parameters

APIURL (http: 1.doc.ineight.com/TBRe APLY)

Name
A% APIURL Userld
A% Userd x Description
28 Company
8 Password
8 Required
Type

Suggested Values

Current Value
[oF

Figure 33: Adding other parametres to enable Reporting API calls.

Step 8: Click on New Source dropdown and select Blank Query

InEight Document Data_r - Power Query Editor

Home Transform

Add Column View T
i E (3
m 1%

Close & New Recent  Enter Data source Manage
Apply~  |Source v|Sources ~ Data settings Parameters *
Close Maost Common Data Sources  Parameters

Queries I Excel Workbook <
4l R -
. SQL Server

fi

x {
D
mm ¥

Analysis Services

Iy
==: Text/C5V
P of
Web
E OData feed
Blank Query
E
More, Blank Query

Write a query from scratch,

Figure 34: Adding a new query to convert into a function
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Step 8: Open Advanced Editor

I | H D})" = | InEight Document Data_r0 - Power Query Editor

Home Transform Add Column Wiew
A I pic:= gk
T .t
Close & Recent  Enter Data source Manage
Apply = EDUFCE * Sources * Data settings Parameters =
Close Mew Query Data Sources  Parameters
Queries [14] <

F Functions [1]
fx Get Report
[ Cueries to Test [6]
F Queries to Load [2]
B _Queryl
I! A'c Query2
[+ Other Queries [3]

Tools

Help

D [:2= Properties

o

L | LT Advanced Editor
Refresh

Preview = ] Manage -

Query

K

Figure 35: Open Advanced Editor to convert Query 2 to a function

Step 9: Copy and Paste the following script and click DONE
(ProjectNoFromQuery as text, reportNo as text) =>

let

Source =

(Web.Contents(APIURL, [Headers=[Accept="application/json", #"Content-Type"="application/x-www-form-

urlencoded;charset=UTF-8"],

Content=Text.ToBinary("UserID="& Userld &

"&CompanyID="&Company&"&Password="&Password&"&ProjectNo="& ProjectNoFromQuery &

"&Application=APIDemo"), RelativePath="session"])),
SessionKey = Json.Document(Source),

SessionKeyHeader = "Basic " & SessionKey,

Sourcel=Json.Document(Web.Contents(APIURL, [Headers=[Authorization=
SessionKeyHeader],RelativePath="Report/" & reportNo, Timeout=#duration(0,0,30,0)]))

in

Sourcel
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H C&~ = | InEight Document Data_r0 - Power Query Editor
Home Transform Add Column View Tools Help

@ B [s [ e e E X E

T Data Type: Any = 2 Merge Queries - = Text Analytics
lh =

T Advanced Editor 2 [ Use First Row as Headers = i Append Queries = <G Vision
Close&  New Recent Enter Datasource  Manage  Refresh Choose Remove  Keep Remove Split  Group
Apply=  Source ~ Sources~ Data settings  Parameters~  Preview ~ (] Manage ~ Columns ~ Columns = Rows ™ Rows ™ Column- By 2 Replace Values [£2] combine Files A azure Machine Learning
Close New Query Data Sources  Parameters Query Manage Columns Reduce Rows  Sort Transform Combine AlInsights
Queries [14] < K
P Functions [1] il Advenced Editor o x
b I Queries to Test [6]

Pl Queries to Load [2]
F Queryl Q ue ry2 Display Options = @

1 (ProjectNoFromuery as text, reporto as text) =>
b I Other Queries [5] 2

3 let

4 Source =

5

6

(Web.Contents (APTURL, [Headers=[Accept="application/json”, #"Content-Type"="application/x-www-forn-urlencoded;charset=UTF-5"],

Content=Text.ToBinary("UserID="8 Userl¢ & "&CompanyID="&Company&"&Password="EPassWord&"&Projectio="& ProjecthoFromQuery & "&
Application=APIDemo"), RelativePath="session"]}),

SessionKey = Json.Document(Source),

8 SessionKeyHeader = "Basic " & SessionKey,

Sourcel= Json.Document(keb.Contents(APTURL, [Headers=[Authorization= SessionKeyHeader],RelativePath="Report/" & reportho,
Timeout=#duration(s,8,38,8)1))

1@ in

11 Sourcel

|\/ No syntax errors have been detected. |

Figure 36: Creating power query function to invoke against all projects.

Step 10: Give your Function the name ‘Get Report’ then press ‘OK’

i | E DB' = | InEight Document Data_r0 - Power Query Editor

Home Transform Add Column View Tools Help
=X 75 Properties Lt Yy s 2 I Data Type: Any -
A (s [0 B [a & 2 B X B8 L dh =g
= [ Advanced Editor il [ Use First Row as Headers -

Close & MNew Recent  Enter Data source Manage Refresh Choose  Remove Keep Remove Split Group 1
Apply~  Source ™ Sources ™ Data settings Parameters ~  Preview [F Manage ~ Columns = Columns = Rows~ Rows~ Column~ By 2z Replace Values

Close MNew Query Data Sources  Parameters Query Manage Columns Reduce Rows  Sort Transform

Queries [14] < fx = (ProjectNoFromQuery as text, reportNo as text) =»

I Functions [1]

Enter Parameters
I Queries to Test [6]

4 Queries to Load [2] ProjectoFromQuery
| Example: abc |

E Quenyl
reportMo
| f:t Get Report

| Example: abc |
3 Other Queries [3]

function (ProjectNoFromQuery as text. reportNo as text) as any

Figure 37: Rename the function

Step 11: Repeat Step 8 to add another new query

Step 12: Open Advanced Editor
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Step 13: Copy and Paste the following script.
let
Queryl = let
Source = (Web.Contents(APIURL, [
Headers=[Accept="application/json", Authorization="Basic " & Password],
RelativePath="Company/" & Company & "/User/" & Userid & "/Project"])),
#"Imported JSON" = Json.Document(Source,65001)
in
Source,
#"Imported JSON" = Json.Document(Query1,65001),
#"Converted to Table" = Table.FromList(#"Imported JSON", Splitter.SplitByNothing(), null, null, ExtraValues.Error),

#"Expanded Columnl" = Table.ExpandRecordColumn(#"Converted to Table", "Column1”, {"Int_Proj",
"MailNewCount", "DocsForReview", "DocsForRelease”, "MailUnregisteredCount", "OutstMLCnt", "ProjNo", "ProjTitle",
"ServerUrl", "Int_Server”, "Int_Key"}, {"Int_Proj", "MailNewCount", "DocsForReview", "DocsForRelease",
"MailUnregisteredCount", "OutstMLCnt", "ProjNo", "ProjTitle", "ServerUrl", "Int_Server", "Int_Key"}),

#"Removed Other Columns" = Table.SelectColumns(#"Expanded Columnl”,{"ProjNo"}),
#"Changed Type" = Table.TransformColumnTypes(#"Removed Other Columns",{{"ProjNo", type text}})

in

#"Changed Type"

Help

ols
D [ Properties % Ly =y omes 4 H = Data Type: Text =
o~ 5 B
® =} Advanced Editor x i L [%] se First Row as Headers =
Refresh Choose Remave  Keep Remove Split  Group
Preview - [ M ol ns=  Rows~ - olumn~ By

File lome. sform olumn
s [ B (8

Close & New ent  Enter  Data source
5

Apply~  Sour ces~ Data lanage ~ Columns ws = Rows c 3 Replace Values
Close y Dats Query Manag Reduce Rows  Sort Transform
Queries [14] < Jx || = Table.TransformColumnTypes (#"Removed Other Columns®,{{"Projlo”, type text}})
3 Functions [1] =- [-]
P I Queries to Test [5] ® Valid 100%
47 Queries to Load [3] @ Error 0%
® Empty 0%

E Queyt

Ji Get Report
| [ Query
b B Other Queries [5] 23 distinet, 23 unique

1 | DEFECTTEST
2 | DEFECTIRN
3 DOCUMENTOL
4 EUIFRMUB
5 FORMSTEST
6  FORMSTRAIN
7 FORMTRNEUI
8  PDDEMOL
9 PDDEMO2
10 PDDEMO3
11 PDPSPTEST
12 | PDPSPTEST2
13 TBSTR1

14 TESTRAINING
15 TRAININGSOL
16 TRAININGS02
17 TRAINING504
18 TRIALSOL

19 TRNSFR2

20 UITST2

21 ursT3

22 WDEDEMOA
23 WDEDEMOGAB

Figure 38: Project numbers to be used to invoke the function
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Step 14: Select Add Column tab and Invoke the Get Report function

d | H D~ = | Untitled - Power Query Editor
Home Transform Add Column

View  Tools Help
Conditional Column  ,_#, [/l Merge Columns (. + Trigonometry -
M Al B E I L1 W wdrrrmOO =E e A
i Index Column ~ 155 Extract = % Rounding ~
Column From Custom| Invoke Custom _ Format _ - Statistics Standard Scientific Date Time Duration  Text Vision Azure Machine
Examples - Column| Function [0 Duplicate Column ~  SpParse~ - - - [ nformation - - - - Analytics Learning
General From Text From Number From Date & Time Allnsights
Queries [14] < fr | = Table.SelectRows(#"Changed Type, each ([Projlo] = "TRAININGS@4" or [ProjNo] = "UITST2" or [Projho] = "UITST2"))
3 Functions [1] o
b Queries to Test [5]
40 Queries to Load [3] ® Error
® Empty
M Queryl X
Ji Get Report Invoke Custom Function
| E Query3
b Other Queries [5] 3 distinet, 3 unique Invoke a custom function defined in this file for each row.
1 EEHN= New column name
2 Un= Get Report
3 umsT3 = =
Function query
[(Get Report -]
ProjectNoFromQuery
1 - |[ Proite -]
reportNo
a8 - || 04,001

Cancel

Figure 39: Report Number 04.001 is manually entered.

Step 15: Expand the Get Report column to New Rows

Untitled - Power Query Editor

File Home Transform Add Column View Tools Help
[z Conditional Column . A i1 Merge Columns b + 2 Trigonometry ~ =
E Bl Ex a0 ¥ OB 10 g i = @
¢ Index Column - 173 Extract .0 Rounding -
Column From Custom Invoke Custom . Format _, Statistics Standard Scientific . Date  Time Duration Text  Vision Azure Machine
Examples* Column  Function [C[jDuplicate Column ~  SzParse - - - - Informatlon - - - - Analytics Learning
General From Text From Number From Date & Time Al Insights
Queries [14] < fx = Table.AddColumn(#"Filtered Rows", "Get Report”, each #"Get Report”([ProjNo], "24.e81"))
b 7 Functions [1] . 4B Projlo
I Queries to Test [5] ® Valid 10
4 Queries to Load [3] ® Error ) Extract Values... |
® Empty i -
H Quenyl
fx Get Report
| 0 Query3
I Other Queries [5] 3 distinet, 3 unique
1 | TRAININGS04 List
2 | uITsT2 List
3 | UITST3 List

Figure 40: Transforming the table by creating new rows based on the data against each project
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Step 16: Expand the records in the Get Report column

Untitled - Power Query Editor

File Home Transform Add Column View Tools Help
" . . )
E‘J %J ﬁ ; E Conditional Column . /C. ris] Merge Columns XO [+]—| 102 ATngonometry - E @ @ —_— @
i
" S . = é
fx 1 Index Column ~ ;gc;Ex'tract' z =) 8 Rounding ~
Column From Custom Invoke Custom Format Statistics Standard Scientific . Date  Time Duration Text  Vision Azure Machine
Examples~ Column  Function L[ Duplicate Column - SxParse - - - - Infarmation = - - - Analytics Learning
General From Text From Mumber From Date & Time Al Insights
Queries [14] < fx = Table.ExpandListColumn(#"Invoked Custom Function", "Get Report")
I Functions [1] . A8 Projio [~] Get Report
F Queries to Test [5] | Search Columns to Expand
el Queries to Load [3]
B Quent B (Select All Columns) o
€l
o [ Int_Key
fx Eeiligzni M CheckedOutValue
| FH Query3 B CheckedOut
¥ [ Other Queries [5] DocumentNe
E Rev
3 sts
@ Title
[ Discipline
Category
B Type
B AviDwgFmts
& Int_Apprd
B RwwStatus
Fromid
B Approved
@ Firsthlame v
[ IR
[ Use original column name as prefix
1. List may be incomplete. Load maore
[ 18 [ TRAINING504 Record
Figure 41: Expanding each record and populating the table
.
Step 17: Expand the records in the Get Report column
fr || = Table.ExpandRecordColumn(#"Expanded Get Report”, "Get Report”, {"Int_Key", "CheckedOutValue", "CheckedOut”, "Documentfio”, "Rev”, "Sts", "Title", "Discipline”, "Category”, "Type”, "AviDugfmts”, [ v
(=M 2. Projho [~ 1455 1nt_key [~]455 CheckedOutvalue [~ 555 CheckedOut [~]455 Documentio [+]455 Rev []455 s1s [~]455 Tive [~]9%5 0
o Valid 100% e Valid 100% | ® Valid 100% e Valid 100% | ® Valid 100% | ® Valid 100% | ® Valid 100% | ® Valid 100% | ® Va
® Error 0% | ® Error 0% | ® Error 0% | Error 0% | ® Error 0% | Error 0% | ® Error 0% | Error 0% | ®Er
® Empty 0%  ® Empty 0% | ® Empty 0% Empty 0% | ® Empty 0% Empty 0% | ® Empty 0%  ® Empty 0%  ®En
3 distinet, 0 unique
1 TRAININGS04 3414\ No 0/0-3275-07-006-1-10-104552 | 00 AFC Sertifikat Badan Usaha Jasa Konstruksi AL
2 TRAININGS04 3027 No 0/001-TC-17032022-000 A ] LANDSCAPE DRAWING 000 N
3 TRAININGS04 3028 No 0/001-TC-17032022-001 A ] LANDSCAPE DRAWING 001 LN
4 TRAININGS04 3254\ No 0/001-7¢-17032022-001 8 ] LANDSCAPE DRAWING 001 LN
5 TRAININGS04 3029 No 0/001-T¢-17032022-002 A ] LANDSCAPE DRAWING 002 LN
& TRAININGS04 3030 No 0/001-TC-17032022-003 A ] LANDSCAPE DRAWING 003 LN
7 TRAININGS04 3081 No 0/001-TC-17032022-004 A ] LANDSCAPE DRAWING 004 LN
8 TRAININGS04 3082 No 0/001-TC-17032022-005 A ] LANDSCAPE DRAWING 005 LN
9 TRAININGS04 3033 No 0/001-TC-17032022-006 A ] LANDSCAPE DRAWING 006 LN
10 TRAININGS04 3034 No 0/001-TC-17032022-007 A ] LANDSCAPE DRAWING 007 LN
11 TRAININGS04 3201 No 0/001-TC-17032022-007 8 ] LANDSCAPE DRAWING 007 N
12 TRAININGS04 3035 No 0/001-TC-17032022-008 A ] LANDSCAPE DRAWING 008 N
13 TRAININGS04 3036 No 0/ 001-TC-17032022-009 A ] LANDSCAPE DRAWING 008 N
14 TRAININGS04 3037 No 0/ 001-TC-17032022-010 A ] LANDSCAPE DRAWING 010 N
15  TRAININGS04 3038 | Yes 1/001-TC-17032022-011 A ] LANDSCAPE DRAWING 011 LN
16 TRAININGS04 3039 No 0/001-T¢-17032022-012 A ] LANDSCAPE DRAWING 012 LN
17 TRAININGS04 3040 No 0/001-T¢-17032022-013 A ] LANDSCAPE DRAWING 013 LN
18 TRAININGS04 3041 | No 0/001-TC-17032022-014 A ] LANDSCAPE DRAWING 014 LN
19 TRAININGS04 3042\ No 0/001-TC-17032022-015 A ] LANDSCAPE DRAWING 015 LN
20 TRAININGSO04 3043 No 0/001-TC-17032022-016 A ] LANDSCAPE DRAWING 016 LN

Figure 42: Table populated
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Step 18: Transform data as required.

A | | Cor = | Untitled - Power Query Editor
Home | Transtorm | AddCoumn  View  Tosls  Help
=, @ £8 Transpose. Data Type: Any -1, Replace Values - 5 Unpivot Columns ~ T Aﬁ/c [0 Merge Columns (7 EIE 10 4] Trigonometry - E @ R py
R Fil - B Move - fin 25 Ertract - > B8 8 Rounding -
Group Use First Row Spiit  Format Statistics Standard Scientific , Date Time Duration RunR Run Python
By Headers~ 1] Count Rows = Pivot Column  [] Conwert to List Column~ =~ 5% Parse - o B e Information - = B S saipt  seript
Table Any Column Text Column Number Column Date & Time Column saripts
Cliarz= [Tk < umntypes(wsxpanded Get Reportl”,{{"Projlic", type text}, {"Int_Key", Int64.Type}, {"CheckedOutValue", type text}, {"CheckedOut”, Ints4.Type}, {"Documentlio”, type text}, {"Rev’, v
Automatically detect the data type
b [ Queries to Test [5] ® valid 100% | ® Valid mu% o Valid 100% | @ Valid 100% | ® Valid 100% | ® Valid ® Valid  Valid 100% | ® Va
28 Queries to Load [3] ® Error 0% e Error ® Error 0% | e Error 0% | ® Error 0%  ® Error ® Error ® Error u% =
® Empty 0% e Empty ® Empty 0% | ® Empty 0% | » Empty 0% = Empty ® Empty ® Empty . En
[ Quend
S | —r | || |
| 5o . , ) [T ) s I
b Bl Other Queries [5] 3 distinet. 0 unique 2182 distinct, 1947 unique 2 distinet. 0 unique 3 distinel. 0 unique 1895 distincL 1489 u distinel & unique 17 distinct. 0 unique 1328 distinct, 958 unique 18 dis
1 | TRAININGSODS 3413 No 0 0327507-006110-104592 00 Sertfikat Badan Usaha Jasa Konstruksi
2 TRAININGSOZ 3027 No 0 001-TC-17032022-000 A IRl LANDSCAPE DRAWING 000 LNA
3 TRAININGSO4 3028 No 0 001-TC-17032022-001 A IRl LANDSCAPE DRAWING 001 N
4 TRAININGSO4 3252 No £ 001-TC-17032022-001 8 IRl LANDSCAPE DRAWING 001 N
5 TRAININGS04 3029 No 0 001-TC-17032022-002 A IRl LANDSCAPE DRAWING 002 N
6 TRAININGSO4 3030 No 0 001-TC-17052022-003 A IRl LANDSCAPE DRAWING 003 w
T TRANINGSOS 3031 No 8 001-TC-17032022-004 A Ll LANDSCAPE DRAWING 004 Y
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Figure 43: Select All columns and get Power Query to detect the data type based on the date in each column. (example)

Step 19: Rename the query
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All Properties

Figure 44: Re naming the query as per the title of the report

Step 20: Load the data into Power Bl
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Close the GQuery Editor window and
apply any pending changes.

[ Queries to Test [3] ® Valid 100% e Valid 100%
- Queries to Load [3] ® Error 0% | ® Error 0%
® Empty 0% e Empty

3 distinct. 0 unique

1  TRAINING504 3414
2 TRAINING504 3027
3 TRAINING504 3028

le.TransformColumnTypes (#"Expa

2182 distinct, 1947 unique

Figure 45: This will load the table into the power bi data model with import storage mode
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